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1. INTRODUCTION 

Sidekick Enterprise Solution is a standard system proposed by Cross Technology and Innovation 
(CTI) for the after sales support organization. The main target of this system is to provide field support 
engineers with a handy tool that, together with proper interface modules, simplifies the execution of 
the diagnostic procedures and that allows an easy way to configure electronic boards. 
 
Sidekick is an enterprise-wide system that seamlessly integrates the most up-to-date information about 
Electrolux products into a client software tool.  The client software (SidekickPC) lets you quickly 
diagnose appliances and create spare electronic boards.   This is the User’s Manual of this application. 
 
Data integration between corporate databases and SidekickPC seamlessly occurs by means of web 
services that exploit the latest technologies in order to minimizing update time and improving user 
experience and security. 
  
There are many advantages in using a computer-aided service tool, for example: 

1. the possibility to diagnose the appliances in less time and in a more precise way, thus reducing 
the amount of spare components required to fix the problem and the time of intervention. 
SidekickPC identifies if possible the appliance to test, gets and decodes the internal status of 
the electronic controller, and it executes the diagnostic procedures and troubleshooting steps 
the user requires;  

2. the possibility to create spare electronic boards starting from “generic boards” with a 
programming and configuration procedure. This function ensures that the spare part is created 
in the same way as it was originally produced in the factory.  
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1.1. ACRONYMS AND ABBREVIATIONS 
 
AMI Appliance Mini Interface 
ACK Appliance Connection Kit 
CCF Cycle Configuration File 
CTI Cross Technology and Innovation 
DAAS Domestic Appliance Acquisition System 
ELC Engineering Level Code 
HEX Firmware filename extension 
HTML Hyper Text Markup Language 
LBL Label Definition File extension 
MCF Machine Configuration File 
MDAC Microsoft Data Access Components 
MDI Multiple Document Interface 
MMC Microsoft Management Console 
PC Personal Computer 
PIF Programming Information File 
PNC Product Number Code 
Prog Progressive Insertion Number 
PSS Product Software Storage 
Search Key The database search string extracted from the User Code 
SidekickPC The program for diagnosing appliances and configuring electronic 

boards. 
SKC Service Kit Code 
SP1 Service Pack 1 
SP2 Service Pack 2 
SP4 Service Pack 4 
SSE Service Support Europe 
SYM Symbol filename extension 
TDS Technical Documentation System 
USB Universal Serial Bus 
User Code The string code as entered by the user 
WSE Web Services Enhancements 
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1.2. SYSTEM REQUIREMENTS 
The software prerequisites for SidekickPC are the following: 

1. Microsoft Windows XP SP2 or Vista (except the Starter Edition) 
2. Microsoft Windows Installer 3.1 
3. MDAC 2.8 
4. Microsoft .NET Framework 2.0 
5. Microsoft WSE 3.0 
6. Microsoft Internet Explorer 6.0 SP1 or later 
7. Microsoft SQL Server 2005 Express Edition SP2.  If in your PC you have already installed 

another edition of SQL Server 2005, this item is not required. 
 
The setup program detects all the missing software and, if necessary, it is able to setup 

automatically items 2, 3, 4 and 5.  The setup program is able to detect the absence of the required 
SQL Server 2005 instance but it does not install it automatically.  Later in this document you can 
read how to install Microsoft SQL Server Express Edition 2005 SP2. 

Microsoft Internet Explorer 6.0 SP1 is software prerequisite for all installations of SQL Server 
2005, as it is required for Microsoft Management Console (MMC) and HTML Help.  A minimal 
installation of Internet Explorer is sufficient, and Internet Explorer is not required to be the default 
browser. 

If none of the software prerequisites is installed, the target PCs needs at least 10 GB of free hard 
disk space.  This space includes the optional SQL Server Management Studio Express. 

The minimum RAM quantity required is 512 MB (1 GB highly recommended) while the 
minimum processor speed required is 1 GHz.  A CD or DVD drive, as appropriate, is required for 
installation from CD or DVD media. 

SidekickPC requires at least a monitor resolution of 1024x768 pixels. 
The most demanding application is SQL Server 2005 Express edition.  If you go to the 

Microsoft's web site you can read the exact requirements for this software: 
http://msdn2.microsoft.com/en-us/library/ms143506.aspx
 

http://msdn2.microsoft.com/en-us/library/ms143506.aspx
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1.3. SOFTWARE INSTALLATION 
This paragraph describes the sequence of steps in a typical setup procedure on a PC running 

Windows XP without any additional installed software.  Setup steps may however vary depending 
on the actual operating system and software configuration of the PC. 

You must log on as full Administrator in order to make the installation of the software. 
 

1.3.1. SidekickPC Setup 
1. Run the SETUP.EXE program that is present in the root folder of the distribution CD. 
2. If the .NET Framework 2.0 is not installed, SETUP asks you to install it.  Just press 

Accept to go on: 

 
Fig. 1. Install .NET Framework 2.0 
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3. If the WSE 3.0 Runtime is not installed, SETUP asks you to install it.  Just press Accept 
to go on: 

 

 
Fig. 2. Install WSE 3.0 Runtime 

 
4. If Windows Installer 3.1 is not installed, SETUP asks you to install it.  Just press Accept 

to go on: 

 
Fig. 3. Install Windows Installer 3.1 
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5. After installing the above prerequisites, you are asked to reboot your PC. 

 
Fig. 4. Reboot the system 

6. Reboot the PC, log on as full Administrator and, if necessary, run again SETUP.EXE.  If 
there is no SQL Server 2005 installed instance, you immediately get an error message like 
the following one.  Otherwise skip to step 17. 

 
Fig. 5. SQL Server 2005 Required 
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Press OK to quit SETUP without completing the installation: 

 
Fig. 6. Installation Incomplete 

 
7. Run the SQLEXPR32.EXE program located in the SqlExpress folder in the distribution 

CD and accept the license agreement.  This program checks and installs prerequisites.  At 
the end press Next: 

 
Fig. 7. SQL Server Express Setup – Prerequisites Installation 
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8. After the System Configuration Check press Next: 

 
Fig. 8. SQL Server Express Setup – System Configuration Check 
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9. After entering registration data press Next: 

 
Fig. 9. SQL Server Express Setup – Registration 

 
10. You can keep the default features.  Then press Next: 

 
Fig. 10. SQL Server Express Setup – Feature Selection 
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11. You can keep the default for Authentication Mode (the setup program will later 
automatically change this setting to Mixed Mode): 

 
Fig. 11. SQL Server Express Setup – Authentication Mode 

 
12. Important: select both checkboxes in the Configuration Options window and press Next. 

 

 
Fig. 12. SQL Server Express Setup – Configuration Options 
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13. Keep the default options for Report Settings, then press Next: 

 
Fig. 13. SQL Server Express Setup – Report Settings 

 
14. SQL Server 2005 is ready to install.  Press Install: 

 
Fig. 14. SQL Server Express Setup – Ready to install 
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15. Wait until the end of SQL Server setup, then press Next: 

 
Fig. 15. SQL Server Express Setup – End of Setup 

 
16. Just press Finish to complete the setup procedure: 

 
Fig. 16. SQL Server Express Setup – Optional Steps 
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17. If you have just installed SQL Server 2005 Express, run again SETUP.EXE.  You are 
now prompted to choose the installation folder.  Keep the default settings unless strictly 
necessary.  Please remember that you cannot specify special folders like “C:\Program 
Files”, “C:\Documents and Settings\All Users\Application Data”, or 
“C:\Windows\System32”.  If you do it, the setup will show you an error message and 
rollback the entire process.  This limitation is due to a compatibility issue related to the 
Microsoft Vista operating system: 

 
Fig. 17. Select Installation Folder 
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18. SETUP asks you to choose the settings of the Database that it is going to automatically 
create.  It is possible to specify a database and login created with a previous installation of 
the software.  Keep the default settings unless strictly necessary.  Data Source identifies 
the SQL Server instance that will hold the local database.  Database is the name of the 
local database.  User ID and Password are the credential of the login to the local 
database.  Please remember that, by default, SidekickPC uses “Mixed Authentication” to 
connect to the local database:  

 
Fig. 18. Database Settings 

 
19. Specify the URL and credentials for the Web Services Settings that the application will 

use to download data updates, if you already know them.  For Username and Password 
you should use the login information you have been given with an automatic e-mail 
notification when your account was created.  These are the same credentials that you use 
to access to the reserved area in the Sidekick Portal: 

 

 
Fig. 19. Web Service Settings 
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20. Enter your license number in the Activation Settings window, if you already know it. You 

should use the license number you have been given with an automatic e-mail notification 
when your account was created: 

 

 
Fig. 20. Activation Settings 

 
21. Confirm the installation and wait for the completion of the process.  If any errors occur 

during the setup, an installation log appears.  Otherwise no other dialog appears, except 
the final one. 

 
 

22. SETUP finally completes.  Just press Close to end the process: 

 
Fig. 21. Installation Complete 
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1.3.2. Setup of the USB drivers for the Appliance Connection Kit 
After completing the installation of SidekickPC, there is another important installation that you 

must perform prior leaving the administrative mode in the PC: you must install the USB drivers 
for the Appliance Connection Kit. 

In order to perform this step you must have an Appliance Connection Kit (ACK) that Service 
Support Europe (SSE) should have given you.  You should connect the USB interface of the 
interface module to the PC by means of the supplied cable.  The operating system recognizes that 
this is the first time that you connect the device to the PC and prompts you for the installation of 
the drivers. 

The drivers are copied to the hard disk during the setup of SidekickPC in the USB Drivers 
directory starting from the installation folder.  The default driver directory is: 

C:\Electrolux\SidekickPC\USB Drivers 
 
You can find detailed instructions on how to setup the USB drivers in the “Appliance 

Interface Modules USB Setup v 2.0” manual that is installed during the setup of SidekickPC. 
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1.3.3. SQL Server Management Studio Express Setup 
This section describes the optional installation of SQL Server Management Studio Express.  

The installation of this software is only necessary for software troubleshooting purposes. This is 
a tool for the administration of the local database, only necessary for software support activities. 

In most cases you can simply skip this section. 
 

1. Run the SQLServer2005_SSMEE.msi installer located in the Extra\Microsoft SQL 
Server Management Studio Express folder in the distribution CD.  In the welcome 
dialog press Next: 

 

 
Fig. 22. SQL Server MS Express Setup - Welcome 

 
2. Accept the license agreement, then press Next: 

 

 
Fig. 23. SQL Server MS Express Setup – License Agreement 
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3. Insert registration information, then press Next: 
 

 
Fig. 24. SQL Server MS Express Setup – Registration 

 
4. You can select the default features.  Then press Next: 

 

 
Fig. 25. SQL Server MS Express Setup – Feature Selection 
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5. SQL Server Management Studio Express is ready to install.  Press Install: 

 
Fig. 26. SQL Server MS Express Setup – Ready to Install 

 
6. Wait until the end of setup, then press Finish: 

 

 
Fig. 27. SQL Server MS Express Setup – End 
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1.3.4. Uninstalling SidekickPC 
At a certain point you may want to remove the application from your PC.  You can remove it as 

any other Windows application by means of the Add/Remove Programs applet in the Control 
Panel. 

 

 
Fig. 28. Removing the SidekickPC application 

 
You must log on as full Administrator in order to remove the software. 
 
When you remove SidekickPC, the uninstall procedure asks you if you want to delete also the 

local SQL Server 2005 database.  Please remember that, under Vista, the dialog box that asks you 
to remove or not the database may be hidden by other windows:  the uninstall procedure looks as if 
it is “frozen”.  In this case, you should just check for the presence of the dialog and choose “Yes” 
or “No” to continue. 
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1.4. TROUBLESHOOTING 
In this section you can find additional information that you may need in order to solve 

installation problems. 
 

1.4.1. Manual installation of prerequisites 
Under certain circumstances, the SETUP program may not be able to detect the absence of one 

or more software prerequisites.  In this case you can install them manually prior running the main 
SETUP program. 

In case of need, you should manually install the prerequisites in the following order: 
1. Microsoft Windows Installer 3.1.  Run the \WindowsInstaller3_1WindowsInstaller-

KB893803-v2-x86.exe file. 
2. MDAC 2.8.  Run the \MDAC28\mdac_typ.exe file. 
3. Microsoft .NET Framework 2.0.  Run the \dotnetfx\dotnetfx.exe file. 
4. Microsoft WSE 3.0.  Run the \WSE3_0\Microsoft WSE 3.0 Runtime.msi file 
5. Microsoft SQL Server Express Edition 2005 SP2.  Run the 

\SqlExpress\SQLEXPR32.EXE file.  At this point the SQL Server setup program may 
detect that Microsoft Internet Explorer 6.0 SP1 is missing.  In this case you must stop the 
installation and run \Extra\IE6Setup\ie6setup.exe, prior installing SQL Server. 

6. SQL Server Management Studio Express (optional).  Run \Extra\Microsoft SQL 
Server Management Studio Express\SQLServer2005_SSMSEE.msi. 

 
1.4.2. SQL Server installation problems 

Under certain circumstances, the SQLEXPR32.EXE program may encounter problems 
depending on the actual configuration of the PC and of the network.  These problems are outside 
the control of CTI. 

In case of problems you can find in the internet plenty of information regarding tips and 
workarounds related to setup issues.  You should in particular refer to Microsoft forums dealing 
with the matter. 

Experience collected so far by CTI has revealed two problems regarding the setup of SQL 
Server 2005 Express Edition.  You can find the solution for these problems here: 

http://forums.microsoft.com/MSDN/ShowPost.aspx?PostID=130981&SiteID=1
http://support.microsoft.com/kb/910070/en-us

http://forums.microsoft.com/MSDN/ShowPost.aspx?PostID=130981&SiteID=1
http://support.microsoft.com/kb/910070/en-us
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1.5.  SOFTWARE INITIALIZATION 

1.5.1. License Activation 
After that you have successfully installed the program and the USB drivers you can log off as 

Administrator and log on as a normal user.  At any rate, the first thing that you are required to do 
the first time you run SidekickPC is to activate the software license.  Please remember that, in 
order to activate the software license, your PC must be connected to the internet, unless you use 
Manual Activation.  

The first time you run the software, you can see this message: 

 
Fig. 29. License Activation Request 

 
After you press the OK button, you should execute a few initial configuration steps for your 

software: 
• Language (optional) 
• Internet Settings (mandatory when your PC is not directly connected to the internet) 
• License Activation (mandatory) 

 
You may want to choose a display language other than English.  In this case you must use the 

dialog box that you can see if you select the Language command in the Options menu. 
 
If your PC is not directly connected to the internet, you must select proper Internet Settings.  You 

can see the corresponding dialog if you select the Internet Settings command in the Commands 
menu.  For detailed information on this matter, please refer to the corresponding section later in 
this chapter. 

 
Finally, you must activate your software license by means of the License Manager dialog.  You 

can see this dialog if you select the License Manager command in the Commands menu.  In most 
cases you only need to specify the License Number (if you have not specified it during the setup) 
and press the Internet Activate command: 
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Fig. 30. License Activation Request 

 
After you press the Internet Activate button, you should quickly see the following message: 

 
Fig. 31. License Activation Request 

Press OK and the License Manager dialog should close.   
 
If you cannot connect to the internet the PC where you have installed SidekickPC, you can install 

the license manually by means of the Manual Activation command.  This option requires, 
however, the use of another PC that is connected to the internet. 

To manually activate the software license, you must get the Unlock Code from an activation 
portal available at the following URL: http://www.internetactivation.com: 

 

http://www.internetactivation.com/
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Fig. 32. License Activation Portal 



 
CTI – SOFTWARE DEVELOPMENT GROUP 

 

© 2008 Electrolux Home Products Italy S.p.A, All rights reserved  27  
 
File: SidekickPC Manual v 1.1.pdf - Date: 31/03/2008 
 

 
In INSTALLATION ID you must enter the Install ID code you can see in the dialog box.  In 

LICENSE NUMBER you must enter the personal License Number that has been assigned to 
you.  After you have specified these two pieces of information, you must issue the Generate 
Unlock Code command.  The license activation portal should then display the unlocking code: 

 

 
Fig. 33. Unlocking Code 
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Finally, insert the code displayed in the portal in the Unlock Code option in the License Manager 
dialog, verify the correctness of the License Number, and press the Manual Activation 
command: 

 
Fig. 34. Unlock Code in License Manager 

 
The Internet De-activate command allows you removing the license from your PC.  After you 

de-activate the license in one PC you can activate it in another PC. 
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1.5.2. Internet Settings 
If an internet connection error occurs, please verify that you are really connected to the network 

and check your proxy settings in the dialog that you can activate in Commands >> Internet 
Settings: 

 

 
Fig. 35. Internet Settings Dialog 

Sometimes invalid proxy settings are the reason of internet license activation and local database 
update failures.  By default the setup program activates the option that uses “system default proxy 
settings”.  In some cases this option does not work and you must explicitly specify your proxy 
configuration. 

The Connection Settings section lets you specify the way you are connected to the internet.  The 
following options are available: 

1. Direct connection (don’t use proxy): use this option if your PC is directly connected to 
the internet; 

2. Use system default proxy settings: use the settings you have specified in Internet 
Explorer web browser, if you have installed it in your PC.  If the proxy you are using 
requires explicit authentication (username and password), you cannot use this option but 
you must explicitly specify credentials with the “Use the following proxy settings” 
option; 

3. Use the following proxy settings: use this option to explicitly specify your proxy 
settings.  If you use this option you must fill-in the Proxy Settings section.  The HTTP 
Proxy field allows you to specify the DNS name or the IP address of your proxy.  The 
default TCP port for the proxy is 80.  You can specify another port by separating the DNS 
name (or IP address) to the port number by means of a comma.  If your proxy requires 
authentication, you must specify also the UserName, Password, and Domain fields. 
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1.5.3. Update Dialog 
The Update Dialog allows you to perform the update of the local database by means of a 

connection to the remote web service. You can activate the dialog with the Commands >> Update 
menu item 

The software fully relies on the local database contents.  You cannot operate the software if the 
local database is empty.  For this reason, you must perform the initial full database update, prior 
using the software. 

Local database updates occur in a very simple way and are executed through the interaction of 
SidekickPC with a remote web service that copies information from the Electrolux central Sidekick 
database to your local copy. 

 

 
Fig. 36. Update Dialog 
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The Remote Web Service section lets you specify the connection options for the web service: 

1. Service URL: the intranet or internet address to reach the web service.  Depending on the 
different situations, you can use one of the following URLs: 

a. http://sidekick.int.electrolux.com/SidekickService/SidekickService.asmx 

b. https://sidekick.int.electrolux.com/SidekickService/SidekickService.asmx 

c. http://sidekick.electrolux.com/SidekickService/SidekickService.asmx 

d. https://sidekick.electrolux.com/SidekickService/SidekickService.asmx 
Addresses containing the “int.electrolux” portion, are only visible from inside the 
Electrolux network or through the Access Manager application (intranet).  Electrolux may 
change or remove some of the above URLs in the future.  For this reason, you should ask 
Service Support Europe to know which address you should actually use in your case; 

2. User Name and Password allow you to specify your personal credentials to access the 
web service.  You should use the User Name and Password that you receive by mail when 
your license is activated. You can use the same credentials to enter also the reserved area 
in the Sidekick web portal that, depending on the different situations, you can reach with 
one of the following addresses: 

a. http://sidekick.int.electrolux.com/SidekickPortal 

b. https://sidekick.electrolux.com/SidekickPortal 
Also for the URLs of the Sidekick web portal are valid the same remarks as the URLs for 
the web service; 

3. Response Timeout: this option allows you to specify the maximum response time of the 
web service in seconds.  If you internet connection is very slow and you get a timeout 
error during updates, you can increase this value and try again; 

4. the Test Connection command allows you to connect to the web service to verify if you 
have specified the correct settings. 

You may already have specified the options in this section during the setup of the software. 
 
The Local Database section lets you specify the connection options for the local SQL Server 

database:   

1. Server: the name of the SQL Server instance that stores your local Sidekick database.  By 
default the instance name is (local)\SQLEXPRESS.  You select the server name at 
installation time; 

2. Database: the name of the local Sidekick database.  By default the database name is 
SidekickPC.    You choose the database name at installation time; 

3. the Use Windows NT Integrated Security option allows you to access the database 
through the integrated security of the operating system; 

4. the Use a specific username and password option allows you to access the database by 
means of explicit credentials.  This is the default way to access to local database.  The 
User Name and Password fields allow you to specify your personal credentials to access 

http://sidekick.int.electrolux.com/SidekickService/SidekickService.asmx
https://sidekick.int.electrolux.com/SidekickService/SidekickService.asmx
http://sidekick.electrolux.com/SidekickService/SidekickService.asmx
https://sidekick.electrolux.com/SidekickService/SidekickService.asmx
http://sidekick.int.electrolux.com/SidekickPortal
https://sidekick.electrolux.com/SidekickPortal
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the database.  You choose the user name and the password to access the local database at 
installation time; 

5. with the Connection Timeout and Command Timeout you can specify the connection 
and command timeouts (in seconds) for the operations related to the local database.  
Usually you do not need to alter these settings; 

6. the Test Connection command allows you to connect to the database to verify if you 
have specified the correct settings. 

 
The Settings section lets you specify the type of the update and it shows the date and time of the 

last update.  

1. Full update: use this option if you want to perform a full update of the local database.  In 
this case all local data are removed (if any) prior executing a full copy of the remote 
database contents to the local database.  The full update involves all Electrolux appliance 
models (PNCs) supported by Sidekick. A full update is mandatory prior using the 
software for the first time after the setup; 

2. Incremental update: use this option if you want to download only the new records from 
the remote database.  This is the most common update after the initial setup. The 
incremental update involves all Electrolux appliance models (PNCs) supported by 
Sidekick; 

3. PNC update: use this option if you want to download only the new records related to a 
certain set of PNCs from the remote database.  The PNC List entry allows you to specify 
the list of PNCs (one or more up to 20) that you are interested in. The PNC list is a 
sequence of comma-separated PNCs.  A PNC (Part Number Code) is a numeric code of 9 
digits that identifies a certain appliance model from Electrolux. In the PNC List you 
should not supply the ELC (Engineering Level Code): downloading data for a certain 
PNC means getting the update for all related ELCs.  Instead of commas you can also use     
semicolons (;), hyphens (-), and forward slashes (/) as a separator.  An example of a valid 
PNC List the following one: 914791101,913101218,914521544; 

4. Last update date (server date) displays the date and time of you last Full or Incremental 
update.  Keep in mind that this is the date of the server not the date of your local PC.  
Please remember that the PNC update does not change this value; 

5. the Enable log option creates a log file during the update process.  This option is only 
useful for troubleshooting purposes.  You should not normally enable it. 

 

The Start update command starts the update procedure.  Depending on your update options and 
internet connection speed, the update process may require several minutes to complete.  During 
the update a progress bar and some feedback messages indicate the state of the update process.  
The update occurs within a local database transaction.  This means that if you press Cancel 
update or any error occurs during the update, all changes to the local data will be roll-backed 
and the local data will stay unchanged.    Changes to the local data are committed only at the end 
of the update, if no error occurs. 

The Cancel update command cancels the update procedure. 
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The OK button closes the dialog and saves the settings you have changed. 

The Cancel button closes the dialog without saving the settings you have changed. 
 
As previously specified, prior using SidekickPC for the fist time you must execute a Full update. 
Please press the Test Connection buttons to check if the connection to the remote web service 

and to the local database work. If necessary, select the Full Update option and then press the Start 
update command.  You should see feedback messages indicating the progress of the operation.  
The initial full update may take several minutes to complete, please be patient.  At the end you 
should see the completion notification: 

 

 
Fig. 37. Update Dialog: operation complete 

Press OK and you are ready to start using the software. 
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2. CONNECTING THE APPLIANCE TO THE PC 

CAUTION!  In order to avoid the risk of electrical shock only skilled 

personnel should use and install the Appliance Connection Kit.  The 

connection of all items should occur only when the appliance is powered 

off and, if possible, unplugged from the power supply.  Also the adapter 

module should be off. 

If the Appliance Connection Kit uses the USB interface of your PC, please 

remember that you should always employ a fully-shielded High-Speed 

USB 2.0 cable.  This type of USB cable provides a good level of reliability 

for the communication between the PC and the appliance.  

If you want to diagnose an appliance or update its electronic board configuration, you should 
connect it to the PC.  To connect the appliance to the PC you need to do the following steps: 

• Turn off the interface module (if it has a separate power supply). 

• If necessary, disconnect the interface module from the PC (disconnect the RS-232 cable 
or the USB cable). 

• Turn off the appliance and, if possible, unplug it from the power supply. 

• Open the appliance cabinet in order to reach the electronic board connector.  For instance 
in a typical washing-machine: remove 2 screws from the cover on the backside of 
appliance. 

 
Fig. 38. Appliance backside view 

• Typical washing-machine example: slide the top cover back and (if necessary) remove 
the plastic shield from the electronic board using the plastic tips, which you find at each 
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end.  In some types of appliance you only need to open the plastic tip that protects the 
interface connector in the electronic board. 

• Connect the adapter module to the appliance using the interface cable as shown in the 
following picture. 

 
Fig. 39. Appliance with adapter connected 

 

• Connect back the appliance to the power supply and turn it on. 

• Turn on the adapter module (if it has a separate power supply). 

• Connect the adapter module to the PC using either the modem cable (for the RS-232 
interface) or the USB cable. 

 

 

USB 

 
Fig. 40. Laptop PC backside view 

• Run the SidekickPC software. 
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VERY IMPORTANT NOTE! 

Since the interface module is able to power the electronic board even if 

the appliance is not connected to the mains supply, the appliance may 

detect false alarm conditions if the adapter is turned on before the 

appliance. 

For this reason you should ALWAYS turn on the appliance under test 

BEFORE turning on the adapter and connecting it to the Personal 

Computer. 

Conversely, you should ALWAYS turn off the adapter and disconnect it 

from the Personal Computer BEFORE turning off the appliance under 

test. 
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3. CONNECTING THE SPARE BOARD TO THE PC 

CAUTION! 

In order to avoid the risk of electrical shock only skilled personnel 

should use and install the Appliance Connection Kit.  You should NEVER 

power on the spare board from the mains supply (230VAC) when it is not 

installed in the appliance. 

The adapter interface module provides the necessary power to the board 

during the configuration procedure, without the need of connecting the 

mains supply. 

If you want to create a spare board for a specified appliance, you should connect the naked board 
to the PC for the configuration.  To connect the board to the PC you need to do the following 
steps: 

• Turn off the interface module (if it has a separate power supply). 

• Connect the adapter module to the board using the interface cable as shown in the 
following picture. 

 
Fig. 41. Board with appliance cable connected 
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• Connect the adapter module to the PC using either the modem cable (for the RS-232 
interface) or the USB cable and turn on the adapter module.  This operation turns on the 
spare board as well. 

 

VERY IMPORTANT NOTES! 

You may hear an intermittent beep when the spare board is powered on 

by the adapter.  This beep is due to the fact that the board detects a 

false alarm condition since it is not yet installed in the appliance. 

When you turn on an appliance for the first time after you have 

reconfigured it, or after you have replaced the electronic board, the 

machine may automatically start the electric test (the electric test is 

only used in the factory at the end of the assembly line).  Turn the 

appliance on and off to set it back in normal mode. 

 



 
CTI – SOFTWARE DEVELOPMENT GROUP 

 

© 2008 Electrolux Home Products Italy S.p.A, All rights reserved  39  
 
File: SidekickPC Manual v 1.1.pdf - Date: 31/03/2008 
 

4. SOFTWARE OPERATION 

 This chapter deals with the SidekickPC utility functions.  The program consists of a main 
window that is a container of all other functional windows (forms).  The main window follows the 
Multiple Document Interface (MDI) approach.  Using MDI allows you opening many forms at the 
same time during the diagnostic procedure. 
The following figure displays the main form: 
 

 
Fig. 42. Main Form 

The main form contains the pull-down menu placed just below the title bar.  The main menu 
items are: File, Options, Commands, Window, and Help. 

The Start Page command in the File menu activates the Startup Form. 

The Exit command in the File menu quits the application. 
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The Communication command in the Options menu shows the Connection Settings dialog box 
that allows specifying the maximum communication speed for communicating to the target appliance: 

 

 
Fig. 43. Connection Settings 

You do not usually need to change any settings in this dialog box.
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The Language command in the Options menu shows the Language dialog box that allows choosing 
the display language: 

 
Fig. 44. Language Selection 

The Update command in the Commands menu shows the Update Dialog already described in 
Chapter 1. 

The License Manager command in the Commands menu shows the License Manager Dialog 
already described in Chapter 1. 

The Internet Settings command in the Commands menu shows the Internet Settings Dialog 
already described in Chapter 1. 

The Windows menu contains various commands that simplify arrangement of forms in the 
workspace. 

The Help menu contains only the command to display the About Dialog box. 

 



 
CTI – SOFTWARE DEVELOPMENT GROUP 

 

© 2008 Electrolux Home Products Italy S.p.A, All rights reserved  42  
 
File: SidekickPC Manual v 1.1.pdf - Date: 31/03/2008 
 

4.1. Startup Form 
When you run the program you see the Startup form:  

 
Fig. 45. Startup Form 

There are three objects on the form: the Select COM port list, the Diagnostic button, and the 
Configuration button. 

The Select COM port list lets you choose the communication port. The software automatically 
detects the available serial ports on the PC and, if possible, it selects the port that you have selected in 
the previous SidekickPC session. 

 The Diagnostic button lets you start the appliance diagnostics function. After successful 
appliance detection, the program shows you the Identification form with the main configuration 
parameters in the connected appliance. 

 The Configuration button lets you enter to the board configuration function. When you press 
this button, SidekickPC shows you the Board Configuration form. 
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4.2. Configuration Form 
This is the form that appears when you press the Configuration button in the Startup Form.  

The Configuration form allows you either to create a spare board or to upgrade the electronic 
configuration of an appliance. 

 
Fig. 46. Configuration Form 

The Code Selection field lets you enter either the PNC/ELC of the appliance that you want to 
upgrade or the Service Kit Code (SKC) of the configured spare board that you want to create.  In 
practical terms, these codes identify the model of the appliance. 

The PNC/ELC is an 11-digit code.  The SKC is a 15-digit code beginning with 973.  A 
PNC/ELC code corresponds to one SKC and vice versa.  This means that you obtain the same result if 
you enter either the PNC/ELC code or the corresponding SKC. 

You can insert optional blank characters, hyphens and slashes, between one digit and another, 
to increase the readability of the inserted code.  The software ignores all extra characters that you may 
insert for improving the readability of the code.  

SidekickPC keeps a list with the most recently used codes.  You can click the select button 

( ) on the right side of the Code Selection field and choose one of these items instead of manually 
entering the digits each time you enter a new code. 
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When you press the ENTER key, SidekickPC searches for matches with the specified code in 
the internal database.  If it finds the specified code, SidekickPC automatically processes the 
information for the configuration of the specified spare board. 

If the specified code does not exist in the database, the software just shows an error message. 

If the specified code exists in the database, you can then enter the number of identical boards to 
configure: 

 
Fig. 47. Quantity Definition 
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After the quantity definition, press the ENTER key again and you are ready to start the 
configuration.  This means that you can connect the appliance board to the PC and press OK to start 
the programming procedure: 

 
Fig. 48. Start Programming 

When you press the OK button to start the configuration of the board, at first the program 
identifies the naked board.  If the naked board you are using is not suitable for the appliance model you 
have selected, SidekickPC issues an error message and prevents you further actions with the board.  
Otherwise it immediately starts the board configuration procedure. 

The board configuration procedure occurs using the information contained in the local 
database. During the execution of this command the target device goes into a special mode. After the 
programming procedure, SidekickPC resets the board and it performs a check of the configuration. 
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The Last operation results textbox shows the result of the last board programming operation.  
The GREEN color highlights successful result, RED failure.  In case of success, you can see statistics 
regarding the operation.  In case of failure you can see a description of the error: 

 
Fig. 49. Last operation result 

Please note that all board programming operations are recorded in the local database (Database 
Log) and that are uploaded to the remote server whenever you execute a database update operation. 
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VERY IMPORTANT NOTES! 

The board may become unusable if the board programming operation 

fails for any reason. 

During the programming procedure it is highly recommended not to 

detach the connection cables, not to switch off the interface module, or 

otherwise interrupt the operation since the board may become unusable.  

Interrupting a programming operation may lead to an unusable naked 

board. 

In the above cases, recovering the board may require special 

programming tools.  This program does not provide this capability. 

 

4.2.1. Configuration Form Menu Commands  

The Configuration form has a pull-down menu with the following items: File and Options. 

The Exit command in the File menu just closes the form. 

The Additional Verify command in the Options menu shows the Additional Verify dialog box 
that allows activating an extra configuration step after the board programming procedure: 

 
Fig. 50. Additional Verify Dialog 

This dialog allows you to enable/disable an additional board configuration check and set the 
coverage of memory locations (in percent of whole memory space) that will be checked after the 
programming procedure.  Greater values mean more verifying time.  The minimum coverage value is 
5%. 
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The Images command in the Options menu shows the Images dialog box that allows managing 
image files for the naked board and interface modules: 

 
Fig. 51. Images Dialog 

The software supports the following graphic formats: BMP, JPG, GIF, TIFF, and PNG.  Starting 
from the root folder of the application, there is a folder called “Images” that contains the following 
subfolders: 

• Adapters (for storing the adapter images) 

• Naked Boards (for storing the naked boards images) 

The name of the image files for the naked boards is the code of the naked board.  The extension 
depends on the actual picture file format.  For example for bitmap files: the bitmap image of the naked 
board whose code is 132148224 is 132148224.bmp. 
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The name of the adapter picture files is the value of the Adapter entry in the Programming 
Information File stored in the local database.  The extension depends on the actual picture file format.  
For example for bitmap files: the bitmap image of the “Standard DAAS Adapter” is “Standard DAAS 
Adapter.bmp”. 

Image files are not essential for the proper execution of board programming operations..  The 
software executes the programming of the board even when image files are not present, not reachable 
in the path, or corrupt. 

 

The Programming Log command in the Options menu shows the Programming Log dialog 
box: 

 
Fig. 52. Programming Log Dialog 

The Programming Log dialog shows you information regarding board configuration activities. 
The program is able to keep a track of all boards that have been configured in the workstation. 

Each record stores the information regarding a programming operation.  The meaning of each 
field in the programming log record is the following: 

• Event Date: date and time of the programming operation; 
• Event Type: a string that identifies the result of programming (ERROR, SUCCESS); 
• Log Code: a short string that stores the code as inserted by the operator; 
• Description: additional information regarding the programming operation; 
• PNC/ELC: the PNC/ELC in the database record selected for programming the board; 
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• Prog: the progressive insertion number that identifies the database record selected for 
programming the board; 

• Service Kit Code: the service kit code related to the spare board to configure; 
• Naked Board Code: the code of the naked board; 
• Naked Board Code From TDS:  the code of the naked board as specified in the TDS database; 
• Naked Board Firmware: is the firmware identification string in the board before the 

configuration step; 
• MCF: code and revision of the PNC parameters stored in the board.  For Fabric Care 

appliances this field refers to the Machine Configuration File (MCF); 
• CCF: code and revision of the base model parameters stored in the board. For Fabric Care 

appliances it refers to the Cycle Configuration File (CCF); 
• Configured Board Firmware: firmware identification string in the board after the 

configuration step; 
• Configured Board SN: serial number stored in the configured board, if any.  The serial number 

provides the date and time of the programming operation.  It is a decimal number with the 
following format: 
YYMMDDHHmm 
YY programming year modulus 40 (0..39 => 39=2039, 00=2040) 
MM programming month (01..12 => 01= Janaury, 12=December) 
DD programming day (01..31) 
HH programming hour (00..23) 
mm programming  minute (00.59) 
Example: 708081155 => this serial number indicates that the board has been programmed on 
the 8th August 2007 at 11.55 AM. 

• Algorithm Name: the algorithm used for programming the board; 
• Communication Speed: the actual communication speed (baud rate) employed for board 

programming; 
• Always Replace Firmware: when this flag is ‘true’, the program always overwrites the 

firmware even when the same firmware is already present in the target board; 
• Skip Verify After Programming: when this flag is ‘true’, the program skips the check of the 

operation after the board programming step. 

Electrolux uses the programming log information both for collecting data that is useful for 
improving the quality of products and for troubleshooting problems that you may experience while 
programming electronic boards. 

The software uploads the programming log to the central Sidekick server each time you execute 
an Update operation. Programming log records are removed from your local PC after each update 
operation if they are older than a specified period called “programming log retention time”.  The 
programming log retention time is typically 30 days. 
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The Spare Board Label command in the Options menu shows the Label dialog box that allows 
the activation of label printing after each board programming operation: 

 
Fig. 53. Label Dialog 

This dialog box allows you to enable/disable printing one or more labels after the successful 
programming of each board.  You can select how many identical labels to print for each board (the 
number is limited to 10 labels). 

The Layout File field you define the label layout by means of external files (*.lbl).  Only after 
you choose a layout file, Print Sample and Designer commands will work properly. 

According to the Print Options, the Print Sample command lets you preview or print a sample 
of the selected label. 

Press the Designer button if you want to enter the integrated label layout Designer.  The Label 
Designer enables you to modify an existing layout, to create a new one from the scratch, and to print 
sample labels.  This is a graphical editor that provides you with the full control over the label 
appearance and contents.  The Designer Metrics options allow you to specify the units of measure the 
editor displays.  The description of the layout Designer is outside the scope of this manual. 
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The following is an example of label that you obtain:  

 
Fig. 54. Label Example 

As you can see, the label shows all identification data regarding the spare part, appliance 
model, and database record used for the configuration: 

973 914 791 101 00/4 is the Service Kit Code formatted for better readability; 

00-01-132197270.000-132225610.000-W4A30111.000 indicates which database record has 
been used for programming the spare part or upgrading the appliance configuration.  Each peace of 
information is separated from the following one by a hyphen.  In the above example, from left to right, 
the meaning of the various fields is the following one: 

00: ELC field in the selected record.  Sometimes the ELC field may be different from 
the ELC that the Service Kit Code specifies; 

01: Progressive Number field (Prog) in the selected record; 

132197270.000: code and revision of the PNC parameters (machine configuration file 
for Fabric Care appliances) programmed in the configured board; 

132225610.000: code and revision of the base model parameters (cycle configuration 
file for Fabric Care appliances) programmed in the configured board; 

W4A30111.000: code and revision of the firmware programmed in the configured 
board; 

SN = 708081155 created with SidekickPC 1.0 shows the serial number stored in the 
programmed board (if any).  The meaning and format of the serial number has been previously 
described in this chapter, in the section that deals with the programming log. 
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4.3. Identification Form 
This is the form that appears you when press the Diagnostic button in the Startup form and 

when the connection with the appliance is successfully established.  You enter this form when you 
want to execute the diagnostic procedures on the appliance under test. 

 
Fig. 55. Identification Form 

This panel has four main groups of items.  

The Appliance Identification group provides short information on the current appliance, if 
available (platform, PNC/ELC if known, firmware ID, and board type). 

The Appliance Configuration Data group provides information about the main features and 
configuration of the appliance under test. 

The History button opens the History Form.  This button is not active if the database does not 
specify any history reference information for the connected appliance. 

The Monitor button opens the Monitor Form. 



 
CTI – SOFTWARE DEVELOPMENT GROUP 

 

© 2008 Electrolux Home Products Italy S.p.A, All rights reserved  54  
 
File: SidekickPC Manual v 1.1.pdf - Date: 31/03/2008 
 

4.4. History Form 
The History form provides information about the device usage history stored in the non-volatile 

memory of the appliance. 

 
Fig. 56. History Form 

At the top of History form you can see a list that shows the history information. To see the 
detailed description of each parameter in the Description textbox, just select the corresponding item in 
the above list. 

The actual items listed in the list depend on the appliance model and local database contents. 
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4.5. Monitor Form 
The Monitor form allows you to watch the appliance variables and run the device tests. 

 
Fig. 57. Monitor Form 

At the top there is the Test selection list with all tests for the connected appliance. In order to 
start a test, just select one from the list and press the Start test button.  When a test is in progress, the 
same button becomes Stop test.  In this case, you can use the button to stop the current test and, 
usually, reset the appliance. 

Test Description provides a short description about the selected test (if any). 

In the middle of the Monitor form there is a list of input/output variables that provide meaningful 
information during the diagnostic procedures. In this list you can see some appliance variables values. 
Please note that SidekickPC displays all items whose values are outside the minimum/maximum limits 
in red.  The program updates these values every second. To see the detailed description of the variable 
in the Variable Description field, just select click the corresponding item. 

The Graph button allows you to enter the Graph form that allows you to see some parameters in 
graphical form. 
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The Reset Alarm button resets the last alarm stored in the non-volatile memory of the electronic 
board.  This command is only active if the local database defines a procedure to reset the last alarm.  
Please note that if one alarm is currently still active, you cannot clear the last stored alarm as it will be 
immediately set back again. 

The Troubleshoot button shows the list of troubleshooting procedures defined by the local 
database for the appliance under test (if any). For more information on the troubleshooting feature of 
SidekickPC, please refer to the next paragraph. 

The Digital I/O button allows you to enter the Digital I/O form that displays the current state of 
the digital inputs and outputs in the appliance. 
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4.5.1. Troubleshooting Wizard  

If the local database defines troubleshooting procedures for the appliance under test, the 
software is able to guide you step-by-step to the resolution of the fault, starting from the alarm code. 

A troubleshooting procedure is a sequence of interactive dialog boxes. 

When there is an alarm condition and the software detects that one troubleshooting procedure is 
associated to that alarm, the Troubleshoot button in the Monitor form becomes red: 

 
Fig. 58. Available Troubleshooting Procedure 



 
CTI – SOFTWARE DEVELOPMENT GROUP 

 

© 2008 Electrolux Home Products Italy S.p.A, All rights reserved  58  
 
File: SidekickPC Manual v 1.1.pdf - Date: 31/03/2008 
 

If you press the Troubleshoot button you can see the Troubleshooting List dialog: 

 
Fig. 59. Troubleshooting List 

This dialog shows the list of all available troubleshooting procedures in the database.  All 
procedures that are related to the current alarm condition (if any) are highlighted in red.  In order to 
start the Troubleshooting Wizard for a certain procedure, just select it from the list and press the Start 
command. 
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Each step consists in a dialog box that shows instructions and up to two images: 

 
Fig. 60. Troubleshooting Wizard Step 

The instructions provide information regarding the specific operation to execute.  You should 
provide a result to the wizard in terms of a Yes or No answer.  The next step, if any, depends on the 
answer you provide. 

Troubleshooting steps either can be only manual or can involve the interaction with the 
electronic board.  The management of such interaction is completely automatic for the end user.  
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4.6. Graph Form 
The Graph form allows you to see the evolution of the appliance parameters in graphical form. 

 
Fig. 61. Graph Form 

To see the graphical representation of one appliance variable, you should choose it from the 
Variable selection field at the top of Graph Form. Click with the mouse the selection button ( ) and 
choose the variable name.  The detailed description of the variable appears in the Variable 
Description field.  In the Current Value field you can see the present value of the selected parameter. 

The Maximum Display Interval (min) control allows you to select the display width of the 
graph.  The default interval is 1 min, but you can change it from 1 minute up to 2 hours.  For each 
variable, the program reads a new data sample from the appliance every 1 second. 

The Print button allows you to create a hardcopy of the current graph. 
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4.7. Digital I/O Form 
The Digital I/O form displays the current state of the digital inputs and outputs in the appliance. 

 
Fig. 62. Digital I/O Form 

You can see a list of the digital inputs and outputs states that are meaningful during the 
diagnostic procedures. The program updates these values every second. 

To see the detailed description of each parameter in the Description, just select the 
corresponding item in the list. 
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